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Welcome to ViaPrint!
ViaPrint is an all purpose Windows Printing Utility that uses a "drag and drop" interface for 
the easy creation of all types of labels - and more.    Use ViaPrint for:

- Mailing Labels
- Flyers
- Business Cards
- Cassette Tape Labels
- Video Tape Labels
- More!    Your imagination is your ViaPrint's only limit.

If you've been looking for something quick and uncomplicated to handle your custom 
printing needs, ViaPrint is for you.    We've packed lots of features into ViaPrint to make it 
as easy and fast to use as possible.

ViaPrint Features:
* "What You See Is What You Get" document design.

* Import your favorite Pictures.    Add up to 10 .BMP (Windows Bitmap) or .WMF (Windows 
Metafile) pictures to your label or flyer.

* Print MAILING Labels using ViaPrint's Database Printing Capability! "Comma-Delimited 
ASCII" format, dBASE IV format, and the new ViaBase format are supported.

* Text Rotation!.    Rotate your text to any angle for attention grabbing headlines or tiny 
copyright notices.

* "Drag and Drop" text, box, and picture placement.

* Line Box and Picture Resizing.    Stretch your pictures and boxes to the size you need 
using your mouse.

* Easy to use, up front controls.    Make use of all your True Type fonts.

* Built in Font Viewer and Character Selector.    Use your "WingDing" or "DingBat" fonts for 
interest effects.

* Color capability.    Use colored fonts and boxes for special effects.



Program Requirements:
IBM Compatible Computer with an 80286, 386, 486, or Pentium processor running 
Microsoft Windows 3.x.
A hard disk drive.
A mouse is required.
A printer.



Ordering/Licensing Information
ViaPrint is Shareware.

The Shareware version of ViaPrint may be evaluated for a period of 45 days, if you 
continue to use the program after that initial evaluation period, you must purchase the 
program.    For Site Licenses and Multiple purchases see below.

IMPORTANT NOTE ON LIMITATIONS:

The shareware version of ViaPrint produces printed documents and labels with the 
"watermark" - ViaPrint Unregistered -. The commercial    version, ViaPrint Ultra, doesn't 
print this watermark, of course.    This shareware version watermark will appear on the first
label of each page.    

In addition, after your 45 day evaluation period has expired, a Timed Reminder Window 
will appear every time you use any of ViaPrint's major functions.    Upon ordering we'll give 
you a code that will turn off the Reminder Window.

Ordering ViaPrint Ultra v3.0
To purchase the commercial version, ViaPrint Ultra 3.0, send $34.50 ($30.00 + 4.50 
shipping and handling).    For your fee you will receive ViaPrint Ultra along with the 
following:

- As a registered User of ViaPrint Ultra, you will be able to purchase ViaBase, 
Viable's new multi-purpose database program, for HALF PRICE: $25.00 instead 
of the normal price of $49.95.

- Notification of updates.    ViaPrint will be updated with new features and 
conveniences (and bug fixes) regularly.    Registration will insure that you 
receive notification of, and significant discounts on, all future updates.

- Technical Support by Telephone.    (We cannot offer phone technical support for
the Shareware Version, but you are welcome to write us with any problems...)



- A printed ViaPrint Manual.    Our little 5" x 8" manual will make learning and 
using ViaPrint a breeze.

- Full Picture and Angle Box Capability.    Use up to ten Picture Boxes and Angle 
Boxes per label!    The shareware version is limited to two of each.

- A full range of the AveryTM Preset Label Templates.    The Shareware version of
ViaPrint allows printing of only the first twenty Avery Label Templates.    The 
commercial version lets you print them all!.

- Viable Software Alternatives' Shareware Programs, Your ViaPrint will come 
with at least THREE other shareware programs including the latest versions of 
our popular Windows games, World Empire II, Poke-It Poker!, and our new Label 
database for Windows, ViaBase (When ViaBase becomes available, probably 
January, 1995).

Please Order Soon!
In The U.S., Mexico, Canada, Central and South America, Africa, 
and Asia:

Send ONLY $34.50 for each copy needed (Site Licences are available: $30.00 each for 
quantities from 2 to 5; $25.00 each - 5 to 15 copies; $20.00 each - over 15 copies) to:

Viable Software Alternatives
PO Box 98134
Las Vegas, NV      89193-8134
USA

Or Call:

1-800-854-4902 with your MasterCard or VISA number.
                          (ORDERS ONLY, please.    For Site Licensing info or other questions call 618-
549-5227.    Please do not use this 618 number for support calls regarding the SHAREWARE
version.    Support on shareware versions is offered by mail only.)

In Europe and the UK (See below for Germany And The 
Netherlands):

Send ONLY Pounds: £26.97 (£19.95+ Shipping £3.00 + VAT (EC residents) @17.5%        
£4.02) for each copy needed to:

The Thompson Partnership
Church Croft



Bramshall
Uttoxeter, Staffs
ST14 5DE

        Or Call:

                    Phone +44 (0)889 564601
Fax          +44 (0)889 563219�
BBS        +44 (0)889 568625
(MasterCard, Visa, American Express, Diner's Club)

In Australia and New Zealand:

Send ONLY $59.00 for each copy needed to:

BUDGETWARE
PO Box 496
Newtown NSW 2042
Australia

Or Call:

Phone      (02)519-4233
Fax              (02)516-4236

 (Cheque, Money order, Bankcard, MasterCard, and Visa)

In Japan:

Contact for local registration.

P. & A. Shareware
302 Bellwins, 1367-23
Nakagami, Akishima
Tokyo, 196 Japan

            Or Call:

Phone        0425-46-9141
Fax                0425-46-9142
Nifty              PAF02461
(Credit Cards, on Nifty, by bank and/or postal transfer, COD, etc...)

In Germany:

Send ONLY DEM: 69.-- For Each Copy Needed To:

PD-PROFI ZOTTLEIN
SOFTWARE VERTRIEBS GMBH
SCHULSTRASSE 13
D-86666 BURGHEIM
GERMANY

        Or Call:



Tel.    +49 (0)8432-1296
Fax. +49 (0)8432-8674
MasterCard, VISA, Lastschrift    (zzgl. Versandkosten DEM 10.--, Nachnahme    (zzgl. 

Versandkosten DEM 12.--)

In The Netherlands:

Geregistreerde versie ViaPrint Ultra:    Fl.    79,00
Verzendkosten:    Fl.        7,50
                  Rembours:    Fl.    12,50

----------------------
        Totaal:

BroCo Software
postbus 446, 3760 AK    SOEST
The Netherlands

        Or Call:

Tel: 02155-26650
Fax: 02155-14012

Wijze van betaling:    (    ) overmaking postbank 28.39.530
(    ) overmaking rabobank 37.99.42.844
(    ) overmaking bank België 172.13.06.755.45
(    ) onder rembours ( Fl.12,50 verzendkosten )
(    ) Euro/MasterCard

Thanks for trying ViaPrint!



ViaPrint's Main Edit Screen:
ViaPrint creates a label on the screen the same size as the label you want to print.    You 
only see one label on the screen, but when it is printed, it will be printed as many times on
the page as you specify in the Setting Label Size And Page Setup... Window.

After selecting or entering the label size you want in that window, you simply add Text 
Boxes... (lines of text),    Picture Boxes... (.BMP or .WMF picture files), Angle Boxes... 
(special text boxes that you can rotate), and Line Boxes... (decorative lines and frames to 
enhance your label), drag them around the Screen Label and resize them to look like you 
want - then print your labels, business cards, flyers, etc... on your printer.    It's that easy.

            Edit Box...              Object Move Buttons...                                                                                               
Database Controls...

Guidelines...                                                                                Line Box...                    Text Box...                     
Screen Label...          Shortcut Icons...
                                                          Picture Box...

ViaPrint Object Priority...

Text Boxes, Picture Boxes, etc... are treated as objects in ViaPrint.    As such, each has its 
own place in the scheme of things and each has a priority.    Think of this priority as a 
physical position on the screen depth-wise.    Line Boxes have the lowest priority - all other 
objects are placed on top of Line Boxes.    Angle Boxes come next, then Text Boxes, and, 
finally, Picture Boxes have the highest priority in ViaPrint.    That means that a Picture Box 
will cover any Line Boxes, Angle Boxes, or Text Boxes that it is placed on top of - unless 
you've selected "Imbed Picture Boxes...".



To access a Line Box that is entirely hidden by an un-imbedded Picture Box, you'll need to 
move the Picture Box so the Line Box is visible.

Individual objects have priorities too.    These are changeable, however, using the "To 
Front" and "To Back" Functions from the Object Menu...



Text Boxes, Picture Boxes, Etc... Objects:
Working with the Text Box:

The ViaPrint Window is easy to use and self-explanatory.    After setting the size of the label
you wish to create using the Page Setup... Window's "Label Width" and "Label Height" text 
entry boxes (for Custom Labels), or selecting the desired Avery Label Template, the Label 
area at the bottom of your screen will change to that size.

Initially you'll see a single Text Box... that says "Blank Line" and that's    highlighted by red 
resizing tabs.

Only the left and right resizing tabs on Text Boxes have any effect in ViaPrint.    They 
change the Text Box's width.    To change the size of a Text Box, click on the left or right 
resizing tab and hold down the left mouse button to "drag" the box until the box is as wide 
as you want it.

As you enter text into the Edit Box..., the text will also be displayed in the current Text Box,
the text wrapping and the height of the Text Box expanding as you type.

You can move the Text Box to any position on the Label by placing the    mouse cursor over 
the Text Box (The mouse cursor will change from a "cross hair" to an "up arrow" when it is 
over a moveable object).    Then depress the left    mouse button and, holding it down, 
"drag" the Text Box to the new location.    Indicators on the horizontal and vertical rulers 
will assist you in lining up Text Boxes evenly.    If you've selected "Snap To Grid" from the 
"Page Setup" Window, the Text Box will align itself to the current grid setting.

Use the Text Menu's Font Name, Font Size, and Font Style Options (Bold, Italic, and 
Underline) tools to display the text in your Text Box the way you want.    You can align the 
text in your Text Box by selecting "Left", "Right", or "Center" - use the Text Menu... from 
the ViaPrint Menu Bar, then select "Alignment".

Use the Edit Box... in the upper left of your screen to change the text in the currently 
highlighted Text Box.

To add another Text Box, select "Add Text Box" from the Object Menu...

Working with the Angle Box:



Angle Boxes... have the capability to display text at an angle.    Otherwise they are much 
like Text Boxes, but:

1. Because of their rotation capabilities, Angle Boxes are a wide as they are high, 
that is, as wide as the text they hold.    This makes them cumbersome as they will "cover" 
any Line Boxes... they're over.    For this reason, it's usually a good idea to add Angle Boxes
after other objects have been created and placed on the label.

2.    When an Angle Box is currently selected, a rotate control will appear next to the 
"Viable" button on your screen.    Use this control to change the angle at which your text is 
displayed.

Use the Fonts Option from the Text Menu... to display the text in your Angle Box the way 
you want.    ALL FONTS ARE NOT ROTATEABLE!    Most True Type fonts will rotate fine.    
(Printout results for Angle Boxes are not yet always accurate! Always test by printing first 
to scrap paper.)

Use the Edit Box... to change the text in the currently highlighted Angle Box.

To add another Angle Box, select "Add Angle Box" from the Object Menu...

Picture Boxes:

This same Add, Drag and Drop technique is used to move Picture Boxes... and Line Boxes 
around on your Label.    The resizing tabs on these two DO affect each, however.

To add a picture to your Label, select "Add Picture Box" from the Object Menu... From the 
"File Type:" List Box in the File Window, choose either .BMP or .WMF (Windows' MetaFile).    
Then select the picture file you want to display, press "Okay", and drag it and resize it until
it's displayed as you wish.

To resize a picture, move the mouse cursor over the resizing tab that corresponds to the 
direction you want to "stretch" or "shrink" the Picture Box.    When the mouse cursor is over
the resizing tab it will change to a double arrow.    Press the left mouse button, and, holding
it down, drag the corner or edge of the Picture Box until it's the size you want. Be patient, 
resizing .BMP pictures takes time!



Line Boxes:

To create a Line Box... you first need to draw the size and position of the Line Box on your 
Label.    Move the mouse cursor to the point where you want the upper left corner of the 
Line Box to be.    The mouse cursor MUST be in the shape of a "cross hair" - if it isn't, that 
means you're already on top of another Line Box, Text Box, Angle Box, or Picture Box. 

Press the left mouse button and, holding it down, drag the mouse cursor down and to the 
right.    As you do this a blue box outline will appear on the Label.    When this box is the 
approximate size of the Line Box you want to create, release the mouse button.

A box will appear - but not yet a Line Box!    When you release the mouse button you'll 
notice that the "Draw Line Box" selection in the Object Menu is selectable.    Click on this 
selection and your Line Box will be created and highlighted - ready to reposition and resize
as you wish.

The color of Line Boxes can specified using the "Color" selection from the Object Menu...    
When a color other than white is selected for a Line Box the box appears opaque - you 
can't see through it.    When white is chosen, the Line Box will appear transparent.



The ViaPrint Controls:
Each Menu or Toolbar Function, and other controls, are explained under the following 
headings:

           File Menu  
           Edit Menu  
           Object Menu  
           Page Menu  
           Text Menu  
           Database Menu  

           The ViaPrint ToolBar  
           Other Controls  



Keyboard Functions

A mouse is required in ViaPrint, however the keyboard will make some operations easier.

To move an object the amount of space that you've set for the label grid, use SHIFT plus 
the ARROW keys.

To change "focus" immediately to the "Edit" box, press F2.

To change which object is currently selected (highlighted) press CTRL plus TAB.



Moving Or Copying A Group Of Objects
To move a group of objects in ViaPrint you first need to draw a box around all of the Text 
Boxes..., Picture Boxes..., Angle Boxes..., and Line Boxes... you want included in the copy or
move.    Place the mouse cursor over the point where you want the upper left corner of the 
box to be.    The mouse cursor MUST be in the shape of a "cross hair" - if it isn't, that 
means you're on top of a Line Box, Text Box, or Picture Box.

With the cursor shaped as a cross hair, press the left mouse button and, holding it down, 
drag the mouse cursor down and to the right, including all of the objects to be moved or 
copied within your box.    As you do this a blue box outline will appear on the Label.    Now 
release the mouse button.

A Move Box will appear around your selected Objects.

Moving:    To move the selected objects, move the mouse cursor onto the center of this 
Move Box and drag it to the new position.    All Text Boxes, Picture Boxes, Angle Boxes, and 
Line Boxes within will be repositioned.    You can continue repositioning until you're happy 
with the results.    When that happens, just click anywhere on the Label OTHER than over 
the Move Box, or click on the "End Move" selection in the Object Menu..., and the move will
be completed.

Copying: To copy the selected objects, click on the "Copy Object(s)" Function in the Edit 
Menu....    The objects you drew your line around will be copied to the clipboard, ready to 
"Paste".



Setting Label Size And Page Setup

There are thirty Preset AveryTM Label Page Templates built into ViaPrint, as well as a "Full 
Page Flyer" size and a customizable size.    Version 3.0 also contains the A4 Avery label 
templates for use with metric measurements.    (Note: The Commercial version, ViaPrint 
Ultra, contains the latest Avery Label Sizes available)

The "Page Setup" Window

Setting Your Label Size and Specifications

Avery PreLoaded Templates

To select one of the Preset Avery Label sizes, select "Label Size and Page Setup" from the 
Page Menu... and the Page Setup Window will appear.    From the "Avery PreLoaded 
Templates" list box at the bottom of the window, select which Avery size you want - or 
choose "Custom" to enter your own measurements.

If you require metric label sizes, first click on the "A4" button in the "Page Size" option box.
This will cause the Avery metric label sizes to be displayed in the "Preset" list box.

Note: The shareware version of ViaPrint will not let you print the last ten Avery label sizes.  
You can get around this limitation, however, by noting the width and margins shown and 
entering them as a "Custom Label".



You can change the Top Margin, Bottom Margin, Left Margin, and Right Margin text boxes 
to compensate for differences in Printers.    Experiment using scrap paper to get your 
margins correct for final label printing.

You can also set the "gutter" between labels here.    The gutter is the unused portion of the 
page that appears between the labels themselves.    In the "Page Setup" Window enter 
gutter sizes in the "Vertical Divider" and "Horiz. Divider" entry boxes.

Unless you've selected the "A4" page size, the Page Setup measurements are in INCHES, 
so a 1/2 inch left margin would be entered as ".5", a 3/4 inch margin as ".75", and so on.

IMPORTANT NOTE:    ViaPrint 3.0 allows landscape printing.    You must set your Windows 
Print Manager to "Landscape" mode - and enter the proper "Page Length" and "Page 
Width" in the "Page Setup" Window.

Custom Templates

Once you've entered all the measurements for a "Custom" or Avery label (margins, page 
size, etc...), you can save the new label "template" by selecting the "Add" button in the 
"Custom Templates" box.    You'll be prompted for a template name and be allowed to enter
a short description of the template.    A few custom templates have been provided for legal
size flyers and a few envelope sizes.    The "Info" button is used to view the template 
description and the "Delete" button deletes the selected Custom Template.

ViaPrint User Preferences

Setting A "Printer Offset"

If your printer has its own internal page size, you'll notice that your label margins don't 
print correctly.    For example, your labels may print fine, but are not centered on the page. 
A number in the "Printer Top Offset" box controls the top margin for all labels. If your 
printout is a quarter of an inch to high or to low, enter .25 or -.25 (negative numbers are 
okay here) in this box.    The same technique works for the "Printer Top Offset".

Grid Settings And Using A Layout Grid:

Since Objects in ViaPrint can be moved anywhere on a label (that's why it's so fast and 
easy to use) aligning objects properly can be a tedious job.    ViaPrint provides a label 
"grid" to help alleviate this situation.

The label grid causes your Text Boxes, Angle Boxes, Picture Boxes, and Line Boxes to 
automatically be "dropped" in incremental positions on your label.    For example, if you've 
set the grid spacing to .25 (one quarter) of an inch, any object you "drop" will adjust itself 
to that spacing.    If you "drop" a Text Box directly below another, the box you "dropped" 
will align itself .25 inches below the first.

There are three contols that affect the label Grid:

The "Show Grid" check box:    Selecting this will cause the grid to be drawn on your label. 
(Large labels with small grid spacings take some time to update with a visual grid, so be 
patient.)

The "Snap To Grid" check box:    If this check box is selected all objects will automatically 



align themselves to the grid when "dropped".    If the check box is unselected, objects will 
stay where "dropped".

The "Grid Spacing" entry box:    The number you enter here determines grid spacing.    Grid 
spacing less than .05 inches will not be shown even if the "Show Grid" check box is 
selected.    The entire label would be blue!

Using the label grid will speed up label design considerably.

Setting A Default Font:

Use the "Default Font" drop down list box to select the font you want ViaPrint to start up 
with.    ViaPrint will automatically use this font when loaded.

Entering A "Saved Label" Directory Path

The "Path For Saved Labels" box is used to tell ViaPrint in what directory you want your 
labels saved.    When a valid directory (path) name is entered here, the "Open" and "Save" 
windows will assume you want that directory.



Printing Your Label Document
Experimentation is the best way to get your labels lined up on the page correctly before 
printing and possibly wasting some expensive label sheets.

The "Label Print Configuration" Window

Printing Procedure:

If you are printing a Custom Label size, before selecting the "Print" Button be sure your 
margins are set correctly in the Page Setup... Window.    After selecting "Print", the "Label 
Print Configuration" Window will appear with a sample label page.

If you want to configure your printout (start printing at a certain label on the page, print 
only a certain number of labels, enter Database specifications, etc...), you can do it here.

WHERE ON THE PAGE TO BEGIN PRINTING:

On the right side of the Label Print Configuration Window is a small version of your label 
page, the Sample Label Page.    To begin print at a label other than the first on the page, 
click on the position of the label where you want to start printing.

PRINTING CUT MARKS

Below the Sample Label Page is a check box, "Print Cut Marks".    If this box is checked 
whey you click on the "Print" Button, Cut Marks will be printed around the margins of your 
printed page to guide you if you do your own cutting.



OTHER:

You can also specify the number of labels per page to print - and the number of pages 
(unless you're printing from a database).    When everything looks right, press the "Print" 
command button.

ViaPrint Database Options:

If you have selected a database to print labels from, four additional controls are visible on 
the screen: 

"START AT RECORD#" entry box - If you want to start printing labels from your 
database at any record other than the first, enter the record number in the "Start at 
Record#" entry box.

"START AT MATCHING FIELD" button - Clicking on this button will bring up a window 
in which you can specify WHICH record you start printing at by matching a field in that 
record.    When this option is set, no records will be printed until a match is found, then all 
records will be printed - as long as they fit the Conditions you have set.

"LABEL COPIES PER RECORD" entry box - The number you type in this box will 
determine how many copies of a database record label are printed.

"REMOVE BLANK FIELD LINES" check box - If this box is checked when you click the 
"Print" Button, ViaPrint will remove blank field lines from multi-line Text Boxes, insuring 
that your labels don't contain blank lines where fields have no contents.    If it is NOT 
checked, ViaPrint will print a blank line where the the field would have been.

The "Set Conditional Fields" Window

Conditional Printing 

You can set up to three Conditional Sentences that filter the printing of labels from a 
database in ViaPrint - using the "Set Conditional Fields" Window.

To set conditions on printing labels (the field in the database must match the information 
you enter here for the condition to be "true" and the label to be printed), click on the Field 
Name list box that appears after the prompt "Print Label If:", and select the field you want 
to conditionalize.



Eight conditions are available and are accessed by pressing the "Equals" command button.
As you click on this button its caption will change to other conditions.    They are: "Doesn't 
Equal", "Is Greater Than", "Is Less Than", "Contains", "Doesn't Contain", "Is Blank", "Is Not 
Blank", and, finally, back to "Equals".

After selecting the condition, enter the text that must be matched in the entry box to the 
right of that conditional command button.    This is the text that must be matched within 
the database record if that record is to have its fields printed within your label.

The varying conditions and their effects are listed below:

Equals: In order for a record to be printed as a label, the database field must exactly
match the textyou entered to the right of the conditional command button (the 
comparison ignores case).

Doesn't Equal: The field must be different from the text you entered.

Is Greater Than: The field must be alphanumerically greater than the text you 
entered.

NOTE: If the database you are using is a dBASE IV compatible database or a ViaBase
database, the field will first be converted to its intended type (ie. Numeric, Date, etc...) 
before the comparison is made.    Because there is no way for ViaPrint to know what type 
of fields are contained in a "Comma-Delimited ASCII" database, all fields within them are 
compared as characters (alphanumerically).

Is Less Than: The field must be alphanumerically less than the text you entered.    
See Note above.

Contains: The field will be scanned tor the text you've entered.    If the text is found 
anywhere within the field, the record will be printed.    For example, if the field you are 
conditionalizing contains the text"1/5/93" and you enter "93" as the conditional text, the 
label will be printed.

Doesn't Contain: The field will be scanned tor the text you've entered, but the record
will be printed only if the text was not found.

Is Blank: The record will only be printed if the field is blank.

Is Not Blank: The record will only be printed if the field is not blank.

A complete Conditional Sentence might look like this:

Print Label If:    Last_Name      Equals      Smith

or:

Print Label If:    Date_Ordered Is Less Than        1/1/93

Between the three Conditional Sentences in the Set Conditional Fields Window are 
command buttons that change from "And" to "Or" and back to "And" again.    These give 
you greater flexibility in conditionalizing your printout.



For example, if you set your Conditional Sentences to read...

Print Label If:
    Last_Name      Equals      Smith

Or If:    Last_Name      Equals Jones

And If: Date_Ordered    Is Less Than        1/1/93

...ViaPrint will print all records of anyone named Smith or Jones that ordered after January 
1, 1993.

To print ALL records in a database, be sure all that all Field Name list boxes in the "Set 
Conditional Fields" Window are set to "Don't Use" (The default).

--------------------------

All possible within our current means was done to insure printer compatibility.    If you have
a problem, write us giving your printer brand and model, and we'll see what we can do.



The Database Menu

"Open Database For Use/Close Database"

When you click on this selection a File Window will appear/.    From the "File Type:" list box 
choose the type of database file you wish to work with, then select which file from list of 
files that appears.    When you've selected a database this option will change from "Open 
Database For Use" To "Close Databasef" and the other four options under this menu will be
accessable.    See "Printing Labels Using A Database File..." for more information.

"Set Conditional Fields"

See "Printing Your Label Document..." for a description of this option.

"View Database"

When you click on this selection, the database you've selected will be displayed record by 
record.    Only records that match the Conditional Sentences you've created will be shown.  
See elsewhere under "Printing Your Label Document..." for more information.

"ViaBase Viewer And Query"

If the Database you opened is a ViaBase File, selecting this option will activated ViaPrint's 
built in ViaBase Viewer.    You can search, sort, and Query the records in the file from here.

"Insert Field"

While you can enter Field Names between brackets yourself, the "Insert Field" option is 
provided to conveniently do this for you.    Select the "Insert Field" option and select the 
Field Name you wish to add from the list box that appears. The selected Field Name is 
inserted into the currently selected Text Box... at the point in the text where the Edit Box... 
cursor currently resides.

Add text, carriage returns, and punctuation between the fields as necessary by using the 
Edit Box...



The File Menu

"New Label Design"

Selecting this option will clear the Screent Label... of all Line Boxes, Picture Boxes, and Text
Boxes, then place a single Text Box at the upper left of the visible part of the label with the
words "Blank Line".

"Open Label Design"

Use this function to load a previously saved label into ViaPrint for editing or printing. Select
the label you wish to load from the list of files on the File Window that will appear and 
press "OK".

"Save Label"

Select this option when you're ready to save your work.    If the label is being saved for the 
first time a File Window will appear.    Enter a name for the saved label and select OK.

The File Extension that ViaPrint uses for saved labels is ".LBL".

"Save Label As"

Use this option to save the current label under a different name.

"Print"

Click on this selection and the Print Configuration Window will appear.    See    "Printing Your
Label Document..." for more information.

"Printer Setup"

Clicking on this selection will cause the Printer Setup Window to appear over the ViaPrint 
screen.    Use this Setup Window to configure your printer for page size, print quality, etc...



"Exit"

Selecting this option will end your ViaPrint session and return you to Windows.    If you've 
not saved the current label since changing it, you'll be given the chance to do so before 
the program ends.



The Edit Menu:

"Copy Object Contents"

Selecting this option will copy the contents of the currently selected Text Box..., Picture 
Box..., or Angle Box... to the clipboard.    Note:    You can copy the picture displayed in a 
Picture Box for pasting into other programs, but you cannot paste pictures directly into 
Picture Boxes.

"Copy Object(s)"

Selecting this option will copy the currently selected object into the clipboard.    If you've 
drawn a Move Box around several objects when you select this option, all included objects 
will be copied.    See "Moving A Group Of Objects..." for more information.

"Paste"

Selecting this option will "paste" the contents of the clipboard onto the ViaPrint Label Edit 
screen.    If a group of objects was pasted, a Move Box will appear around the objects so 
you can place them on your label where you wish.    See "Moving A Group Of Objects..." for 
more information.

"Select Character"

This option activates ViaPrint's Font Viewer and Character Selector.    The character set for 
the font you're currently using will be displayed.    To select a character to include in your 
current Text Box, click on the little box ABOVE that character.    The characters you select 
will appear at the top of the window.    To clear these characters, press the "Clear" button.

Any characters you select will be placed in your Text Box... when you "Close" the Font 
Viewer.    If no characters were selected, the selected Text Box will remain unchanged.

"Insert Incremental Field"

Selecting this option will cause an "Incremental Field" to be inserted into the currently 



selected Text Box....    After clicking on this option, a small Window will appear.    Set the 
maximum for the increment in this Window and click on okay.

If you selected the number "5" as the maximum, the inserted Incremental Field will look 
like:

"<<#5>>"

Add to that the text:

"Disk <<#5>> Of Five"

...and when your labels print the Incremental Field will be replaced by the actual number, 
restarting at 1 when the maximum value you specified is reached.    For example, with the 
Field above if you printed 10 labels that Text Box would print as:

Disk 1 Of Five
Disk 2 Of Five
Disk 3 Of Five
Disk 4 Of Five
Disk 5 Of Five
Disk 1 Of Five
Disk 2 Of Five
Disk 3 Of Five
Disk 4 Of Five
Disk 5 Of Five

You can also use the Incremental Field for Page Numbering if you are printing full page 
flyers or labels.

"Create Ascii Database"

This option will activate the Create and Edit Ascii Database Window, allowing you to create
on the fly databases for printing!    See "Creating Your Own Ascii Database..." for more 
information.

"Delete Object"

Selecting this option will delete (remove from the label) the currently highlighted Text Box, 
Picture Box, Angle Box, or Line Box.    After deletion, the highlight will settle on the last 
edited Text Box.    Careful with this option - there's no Undo feature in ViaPrint yet!

You CANNOT delete the last Text Box on a label.



The Object Menu

"Add Text Box"

Pressing this button will cause a new Text Box... to appear on the upper left corner of the 
visible part of your label.    The new Text Box will have the same properties, ie. width, font, 
font size, font style... as the Text Box that is currently selected when you pressed the "Text 
Box" button.

When the new Text Box appears, it will read "Blank Line".    Just enter your new text into 
the Edit Box.

ViaPrint allows up to 60 Text Boxes per label.

"Add Picture Box"

Pressing this button with your mouse causes a file window to open.    Select the .BMP 
or .WMF picture file that you want to display on your label, and press "OK" on the file 
Window.

The picture you selected will be placed in a Picture Box... and centered in the visible part 
of the label you are editing.    Move the picture to the location you want it to appear and 
resize it as necessary.

The Commercial version of ViaPrint allows up to 10 Picture Boxes per label, the shareware 
version only two.

"Add Angle Box"

Pressing this button with your mouse adds an Angle Box... to your label in the same way 



that a Text Box is added.

The Commercial version of ViaPrint allows up to 10 Angle Boxes per label, the shareware 
version only two.

"Imbed Design Objects"

This option draws the images of your Picture Boxes, Line Boxes, and Angle Box contain into
the ViaPrint Screen Label... background.    This allows you to edit and create new objects 
and place them properly without the other objects interfering with them.    

Using the "To Front", "To Back", and "Object Move" functions will turn off Object Imbedding.

NOTE:    If it is turned on, you must turn off Object Imbedding before you can move or 
resize the imbedded objects.

"Draw Line Box"

This option is not accessable until you have outlined the position for your Line Box on the 
label.    To create a Line Box..., move the mouse cursor over the label and press the mouse 
button when the CROSSHAIR is at the point where you want the upper left hand corner of 
the Line Box to be.    Holding the mouse button down, drag the mouse down until the Line 
Box outline is the size you want it, then release the mouse button.

At this point the Draw Line Box function will operate.    Select it, and your new Line Box will 
be highlighted, ready to move or resize as necessary.

"End Move [No Box]"

If you've drawn a line around objects in order to move them rather than to create a Line 
Box, select this option when your move is completed.    See "Moving A Group Of Objects..." 
for more information.

"Show Object Borders"

This option will draw a line around all Text Boxes and Picture Boxes so you can see their 
location easier.

"Center Object"

Selecting this option will cause the currently selected or highlighted Text Box, Picture Box, 
Angle Box, or Line Box to be centered within then current label.

If you change the font or font size of a centered Text Box or Angle Box, or resize a centered
Picture Box or Line Box, you'll need to re-center them again using this option.

"Snap To Guidelines"

The "Snap To" option has no effect unless the ViaPrint Guidelines are visible.    When the 
Guidelines are visible, selecting this option causes the currently selected Line Box or Text 
Box to position itself in relation to the Guideline settings.



If only the Vertical GuideLine is visible, then the Text or Line Box will only align itself 
vertically.    If only the Horizontal GuideLine is visible, then the Text or Line Box will only 
align itself horizontally.    See "Other Controls..." 

"To Back"

This option changes an object's priority on your label.    For example, if you have two Line 
Boxes that overlap one another, pressing the "To Back" option will cause the current Line 
Box to be displayed under the box it overlaps.    This option has no effect on Picture Boxes.

"To Front"

This option changes an object's priority on your label.    For example, if you have two Line 
Boxes that overlap one another, pressing the "To Front" option will cause the current Line 
Box to be displayed over the box it overlaps.    This option has no effect on Picture Boxes.

"Object Color"

This option is used to change the color of text in a Text Box, Angle Box, or the color of the 
inside of a Line Box.    The Color option has no effect on Picture Boxes.



The Page Menu

"Label Size and    Page Setup"

When you select this option, ViaPrint's Page Setup Window will appear.    Here you can 
select from several preset Avery Label sizes, select a full page flyer, or select "Custom", an
option that allows you to define your own label sizes and margins.

For a more detailed description of Page Setup and margins in ViaPrint, see "Setting Label 
Size And Page Setup..." and "Printing Your Label Document..." elsewhere in this Help File.

"Label Border"

When you click on this selection, you'll find three choices for adding a line border to your 
label.    Click on "None", "Single", or "Double" border, and the appropriate border will be 
drawn on your label.

"Preview"

This option activates ViaPrint's Preview Window, which is especially useful when editing 
large labels or flyers that do not fit on the Windows screen.    Horizontal and Vertical Rulers 
are provided for comparison purposes.

Small labels can be viewed here as they will be printed on a sheet of 8 1/2 by 11 Label or 
Card Stock.

Font sizes on the Preview Window vary, so don't depend entirely on this view.    Print test 
pages on your printer using scrap paper to get an accurate idea of what your printed sheet
will look like.



The Text Menu

"Fonts"

Clicking on this option brings up the Font Dialog Box where you can select the font you 
want your text displayed in, as well as its size, within the currently selected Text Box....

"Normal, Bold, Italic, and Underline"

Three Font Styles are available in ViaPrint, Bold, Italic, and Underline.    To change the style 
a particular font in the selected Text Box is displayed in, select from "Normal", "Bold", 
"Italic", or "Underline".    The selected Text Box will immediately reflect your change of font 
style.

"Text Alignment"

When you select "Alignment" from the Text Menu, you'll find three choices for aligning the 
text in the current Text Box.    Click on "Left", "Right", or "Center", and the appropriate 



alignment will take effect in your Text Box.



Printing Labels Using A Database File
Using ViaPrint To Print Database Labels

(Be sure to check out the sample files included with ViaPrint.    Several of these are 
examples of database printing)

ViaPrint 3.0 allows you to print labels containing data from three types of Database files, 
"Comma-Delimited ASCII", "dBASE IV Format", and Viable Software's own ViaBase.    Most 
other Database programs have the capability of saving their databases in one of the two 
former formats.

What Is A Database?

Databases are lists of information.    Your telephone directory is a database!    Database 
lists consist of Records and Fields.    Using the telephone directory as an example, a 
telephone directory RECORD is the entire entry for one person or household.    That record 
is made up of indiviual FIELDS - which include that person's name, their address, and their 
telephone number.

As another example - you may have a database that lists and keeps track of your Video 
Library.    In your database each movie has its own record.    In each record are fields that 
contain the name of the movie, what the movie is rated, its release date, who directed it, 
etc...

Fields are given names.    For example, the field containing the movie title would be called 
"Movie Name" - the field containing the name of the director would be called "Director", 
and so on.



In ViaPrint, Field Names for dBASE IV and ViaBase fields will reflect the names you gave 
them when you created them in your database.    If you named a field "Director" in your 
database program, you'll also call that field "Director" in ViaPrint as you layout your 
custom labels.

Comma-Delimited ASCII fields, on the other hand, are ASSIGNED names in ViaPrint.    The 
first field in a record is given the name "Field1", the second "Field2", and on through until 
all the fields in a record have been named.

This means, when working with a Comma-Delimited ASCII Database File, you need to know
what the fields are!    ViaPrint tries to assist by reading the first record in the database and 
displaying each field's contents along with the field name.

The rest of this section will assume Comma-Delimited ASCII field names - just to help you 
get used to them.

In ViaPrint field names can be embedded within Text Boxes...    In order to indicate the 
presence of a field name in the Text Box, "lesser than" (<) and "greater than" (>) brackets 
must be placed at the beginning and end of the field name.    For example, entering 
"<<Field10>>" anywhere in a Text Box will cause the data in the tenth field of the current 
database record to be printed in place of the field name.    (As, if you're using a dBASE IV 
file, "<<MovieName>>" would cause the actual movie title field to be printed on the 
label.)

Example:

Your movie database contains three records, each consisting of four fields:

        Field1 (Movie Name)    Field2 (Release Date)    Field3 (Rating)    Field4 (Director)

        Record 1

Gargoyles! 1989 PG13 Sam Jones

            Record 2

Blue Moon 1992 PG Phil Philadendron

            Record 3

Gone With The Rain 1939 G Jim Germain

In a Text Box on your label you enter: "<<Field4>> directed <<Field1>> in <<Field2>>.   
The film was rated <<Field3>>."

When you print your labels, using your Movie Database, the above Text Box will be printed 
as:

First Label:          Sam Jones directed Gargoyles! in 1989.    The film was rated PG13.
Second Label: Phil Philadendron directed Blue Moon in 1992.    The film was rated PG.
Third Label:        Jim Germain directed Gone With The Rain in 1939.    The film was rated G.

Each instance of "<<FieldX>>" has been replaced with the appropriate data from fields in 
your database!



A Step-By-Step Walkthrough For Printing A Database:

Start ViaPrint!    When the ViaPrint Window appears, select "Label Size and Page Setup" 
from the Page Menu... and select or enter the size of label you're going to create - then 
Close the Page Setup... Window. 

Now select "Use Database" from the Database Menu....    A File Window will appear.    Select
the type of database you want to load from the File Type list box.    Now select the 
database you want to use with your labels and press "OK".

The "Insert Field" option under the Database Menu... will now be enabled.    While you can 
enter Field Names between brackets yourself, the "Insert Field" option is provided to 
conveniently do this for you.    Select "Insert Field" and choose the Field Name you wish to 
add from the List Box that appears.    You can then choose to create a new Text Box... for 
that Field Name or just add the Field Name to the currently selected Text Box.

Add text, carriage returns, and punctuation between the fields as necessary by using the 
Edit Text... box.

Continue adding Field Names, text, pictures, and boxes - and changing their font and style 
- until the label is satisfactory. Remember, when the field name is replaced by data from 
your database when the labels are printed - the length of the text will change.    Be sure 
and design your label taking this into account!

Example of an address label Text Box (Using ViaBase Field Names
for clarity):

Because all the field names are in one Text Box, if a field is blank that field and the space 
or carriage return that follow it will not be printed.    This prevents your labels from having 
blank lines.

When your text is formatted, select "Print" from the "File" Menu.    Specify which database 
record to start printing with, where on the page to start printing, and how many records 
(labels) you'll be printing - you can even specify which labels by setting Conditional 



Sentences (See "Printing Your Label Document...")!.

That's it!    You've now printed from a database... this feature will give you real printing 
power!    Experiment a little and soon you'll be printing mailing labels from ViaPrint rather 
than your database or word processor!



The ViaPrint Toolbar
The Edit Box

The "Edit Box...", in the upper left corner of ViaPrint's Tool Bar, is where text is entered.    
Any text you type here is recreated on the label you are currently editing in a Text Box....    
Once text is entered, you may use the mouse to "drag" the Text Box into the    position you 
want.

Pressing the [ENTER] key after entering your text will cause a new line to be started in the 
current Text Box.

Text entered in the Edit Box appears in the current Text Box as you type.    See also 
"ViaPrint's Main Edit Screen..."

The ViaPrint Shortcut Icons

Most Menu functions are duplicated as Shortcut Icons in version 3.0.    From left to right the
Icons initiate the following Menu Options:    

Fonts, Bold, Italic, Underline: See "Text Menu..."

Reduce Font, Enlarge Font:    Each time you click on one of these arrows, 2 Points are either
added or subtracted to/from the size of the font in the currently selected Text Box...    Note:
Some fonts to not dispaly properly in every size and you'll see a box in place of the letters.

Object Color, Add Text Box, Add Picture Box, Add Angle Box: See "Object Menu..."



New Label Design, Open Label Design, Save Label, Print: See "File Menu..."

Copy Object(s), Paste: See "Edit Menu..."

 Label Size and Page Setup, Full Page Preview: See "Page Menu..."



The ViaPrint Shortcut Icons are shortcuts to Menu Functions.    See more under "The 
ViaPrint Toolbar..."



Other Controls
The ViaPrint Guidelines

The Guidelines are normally not visible.    To set a Guideline to a particular measurement 
on your label, move the mouse pointer over either the horizontal or vertical rulers on the 
side and top of the label.    Click the left mouse button and the Guideline will appear at the 
point on the ruler that you specified.

To remove the GuideLines, press the "G" Button at the intersection of the two rulers, and 
the GuideLines will disappear.    Pressing the "G" button again will make the Guidelines 
reappear.

Pressing the "Snap To" Button while one or two of the Guidelines are displayed will cause 
the current Text Box or Line Box to align itself to the Guidelines.



Warranty, Licensing...

ViaPrint is a copyrighted, proprietary program offered "as is", without any warranty of 
merchantability or fitness for a particular purpose, performance, or otherwise; all 
warranties are expressly disclaimed.    By using ViaPrint, you agree that the author will not 
be liable for any use of (or inability to use) or performance of this product, or for any 
damages whatsoever.

The registered version of ViaPrint, ViaPrint Ultra, may be used on only one machine at any 
one time.    Site Licenses are available for multiple copies - See "Registration And Benefits".

This software is being distributed as Shareware.      You may use this program freely for 
forty-five (45) days.    If you use it for longer than forty-five days, you are required to 
register it with the author for $34.50 US.    You may also copy and distribute this 
SHAREWARE VERSION of this program, as long as all the files are distributed intact in a 
single archived file - and the conditions in the accompanying VENDOR.DOC are adhered to.
You may not sell this program, and you may charge only nominal fee for distribution not 
exceeding $8.00 a copy.



The Edit Box is in the upper left-hand corner of the ViaPrint Toolbar at the top of your 
window.    The text you enter here is displayed in a Text Box on the label itself.    See "Text 
Boxes, Picture Boxes, Angle Boxes, and Line Boxes..."



Text Boxes contain the text that will be printed on your label.    The text is entered in the 
Edit Box.    You can drag Text Boxes to where you want them, and resize their width.    See 
"Text Boxes, Picture Boxes, Angle Boxes, and Line Boxes..."



Line Boxes are boxes you draw for display purposes.    You can change their color and use 
them to frame text or pictures - or use them for a label border.    See "Text Boxes, Picture 
Boxes, Angle Boxes, and Line Boxes..."



The text you type in Angle Boxes can be rotated 360 degrees for special effects.    Angle 
boxes only work with True Type Fonts.    See "Text Boxes, Picture Boxes, Angle Boxes, and 
Line Boxes..."



Picture Boxes are used to display bitmap graphics or Windows Metafiles on your label.    
See "Text Boxes, Picture Boxes, Angle Boxes, and Line Boxes..."



The Guideline Button turns the ViaPrint Guidelines on and off.    You can also turn on either 
the horizontal or vertical Guideline by clicking with the mousepointer on one of the rulers.   
See "Other Controls..."



The Screen Label is sized the same as the labels you want to print.    Set the label size 
using the " Setting Label Size And Page Setup..." option from the Page Menu. 



The Object Movers move the current object up, down, left or right, according the the 
currently set grid distance.    These are especially useful if you inadvertantly place an 
object off the Screen Label... where your mouse can't reach it!    Just keep clicking to bring 
the object back into the area of the Screen Label.



The Database Controls become active once you've selected "Open A Database For Use" 
and chosen a database file to print labels from.    See "Printing Labels Using A Database 
File..."



Create Your Own Ascii Database
The "Create" Window:

Creating and printing from your own Ascii database is simple:

Step 1.    Select "Create Ascii Database" from the ViaPrint Edit Menu....



Step 2.    When the "Create" Window appears, select "New" from its File Menu (or click on 
the blank page button).

Step 3.    A small window will come up asking you how many FIELDS you want in each 
record within your new database.    Enter a number between 1 and 18. For example, if you 
are creating a Mailing List database you might enter the number 6.    Field 1 would be for 
each recipient's NAME, Field 2 for their ADDRESS, Field 3 for their CITY, Field 4 for their 
STATE, field 5 for their ZIP CODE, and Field 6 for their COUNTRY if they live outside the 
USA.

Step 4.    When you press Okay on that Window, voila!    Your fields are displayed.    Enter 
data for the first record, making sure that you keep each bit of information in its proper 
field (Don't enter someone's address in the field meant for their state!)

Step 5.    To create a new record, select "Add Record" from the Edit Menu, and a new record
will appear.

Step 6.    When you've entered as many records as you need, choose "SAVE" from the File 
Menu (or click on the disk button), give your new database a name in the File Window that 
appears, and press the OK Button.

That's it!    You can load in the database later and add to it if you wish.    You can add up to 
500 records.

Controls:

The Change Record Scroll Bar:    Use this to advance one record or go back one record.

The Add Button:    The button with the plus (+) sign on it adds a record to your database.

The Sort Button:    The button with the little boxes on it immediately SORTS your records 
alphabetically.    The FIRST FIELD is the field by which the sort takes place, so keep this in 
mind as you decide what order to enter your field information in.

Be sure to look at ViaBase... if you want more database power!



ViaBase!    And the ViaPrint ViaBase Viewer
The ViaPrint ViaBase Viewer

If you've selected a ViaBase database File to print labels from, ViaPrint will allow you to use
ViaBase's Querying power to filter which records are and are not printed. 

To activate the ViaBase Viewer, make sure you have a ViaBase database in use, then 
select "ViaBase Viewer And Query" from the ViaPrint's Database Menu.... Your ViaBase will 
be displayed exactly as you created it.    You can Search, Sort, and Query in order to setup 
your label printout according to your needs.

ViaBase:

ViaBase is finally here!    Create your own custom databases effortlessly, up to 50 Fields 
assignable to eight Field Types: Character, Number, List, Date, Note, Picture/Sound, 
Formula, and Data List.

Color control and design picture and box capability insure you'll be pleased at the results.   
Full featured Search, Search and Replace, Querying, Quick Sums, Sorts, and more!

MANY features that other programs just don't have at all...

If you are an owner of ViaPrint Ultra, you can purchase ViaBase for HALF PRICE, and have 
the perfect pair for printing mailing lists, name tags, video labels, and more... any 
application that requires printing labels from a database.

See the order form for including ViaBase in your order, or send us a check or money order 
for $5.00 shipping and handling, and we'll send you the shareware evaluation version of 
ViaBase!



Commonly Asked Questions:
1. My clip art is in PCX format.    Can I use it?    
Yes, but first    you have to convert PCX files to BMP format using Paintbrush.    To do this:

A.    In Windows Paintbrush choose Open from the File Menu.    
B.    Set the FILE TYPE to PCX.      
C.    Double click on the directory where your PCX files are located.
D.    In    the box that contains the file names, double click on the file you wish to convert.
E.    Using the Save As.. option in the FILE menu, pick either 16 color, 256 color or 24-bit 
BMP format and click on Okay.
F.    Exit Paintbrush and go into ViaPrint.
G.    Choose Add Picture Box... from the Object Menu..., 
H.    In the File Window set the FILE TYPE to .BMP    and double-click on the desired file in 
the correct directory.

That's it!

2.    How do I print just one label?
When you select Print from the File Menu..., the Print Configuration Window will appear.    
Type 1 in the box that asks how many labels you want to print.    Use your mouse to click 
on the label position where you want it printed.    See "Printing Your Label Document..." for 
more information.



3.    My label looks fine in the Page Preview, but when I 
print it everything on the label is too high on the page (too 
low, or too far to the right or left).    What do I do?
Measure the amount that the Page Printout is off,    In the Page Menu... select Label Size 
And Page Setup.....    Look for "Printer Offset"    and enter your measurement    in the correct
box: i.e.,    .25 in the Top Margin box will move everything down one quarter inch.    If the 
right margin is too narrow, enter a negative number in the Left Margin box. If the Top 
Margin is too great, enter a negative number (i.e. -25) in Top Margin to bring everything 
down.    This offset will only need to be entered once.

4.    Can I change fonts within a Text Box?
No. Only one font (size, type, etc.) can exist in any single Text Box...    If you want to 
change attributes, you will need to add another Text Box.

5.    I don't want to print a whole page of the same address 
(title, Item, etc.).    I want to be able to print a different one
on each label.    Do I have to type each one separately?    
Not at all.    By creating one standard format that each label will use, and incorporating the 
multiple label information into a database, you can print out many, many labels. See 
"Printing Labels Using A Database File..."

6.    What is a Database?    
A Database is information that is stored in a standard format for later use.    It could be as 
simple as a list of books, or as elaborate as a set of credit applications.    

Most common, perhaps, is a collection of names and addresses known as a mailing list.      
Each set of information [book title; name & address] is called a record.    The individual 
items that go to make up that record are called fields.

What is important for later use, especially with a computer, is that there is a standard 
format.    (i.e. field #1 will always contain last name; field #7 will always display the 
country name.)    A database is as useful as its consistency.    See "Printing Labels Using A 
Database File..."

7.    My labels are not printing in the font I chose and 
everything is messed up.    What do I do?
You may be running low in regards to Windows Resources.    Close ViaPrint, and completely 
exit Windows.    Restart Windows, go back into ViaPrint, and try printing again!

8.    Can I print bar codes?    



If you install a bar code font on your system, (a number can be found on BBS's or 
Commercial Font CDROMs at your local computer store) you can use it in ViaPrint.    There 
are various types of bar codes, postal bar code and "3 0f 9" being the easiest to use.

9.    Can ViaPrint be used with a Dot Matrix Printer?
Yes, although it was originally designed for a laser printer, it can be adapted.    In both the 
Print Manager and the ViaPrint Page Setup..., the page size must match the label size.    In 
the Print Configuration Window, set the number of pages equal to the number of labels to 
be printed.

10.    Can ViaPrint print in color?
Yes.    If you have a Color Printer!    ViaPrint can print text in 16 colors with pictures in 
unlimited colors. if your printer will handle color graphics.    See "The Object Menu..." for 
setting Text Box, Angle Box, and Line Box color.

11.    When I print in a large font it doesn't look right.    
Why?
Usually the problem lies with the font itself.    It is not a true type font.    It may also not be 
capable of display at certain point sizes, you'll see little boxes where the character should 
be.

Try changing, usually reducing, the size of the font in the Text Box...

12. I can't delete the last Text Box.    Why not?
There needs to be at least one Text Box... on the Screen Label!






